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1. Pregled
1.1 Opis

iVMS-4200 je Video Management Software za HikVision uredaje (DVR, hibrdini DVR, IP kamere, NVR PC DVR
ploce). Maksimalno povezivanje do 256 uredaja, do 50 korisnika, do 8 NVR servera, do 64 kamere na jednom
monitoru, podrska za E-mape, multi-screen prikaz i joS mnogo drugih opcija koje ¢éemo prikazati u ovom prirucniku
za upotrebu. Ovo uputstvo opisuje funkcionalnosti samog programa. Molimo Vas da pre upotrebe, instalacije i
konfiguracije programa, obavezno procitate uputstvo.

1.2 Zahtevi u pogledu konfiguracije racunara
Operativni sistem: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows
2003/Windows XP(32-bit operating system)
Procesor: Intel Pentium IV 3.0 GHz ili jace
Memorija: 1G ili vise

Rezolucija: 1024*768ili visa

Napomena:

® Zbog stabilnosti sistema i boljih performansi pridrzavajte se preporucenih konfiguracija.

1.3 Moduli

iVMS-4200- Kontrolni panel:

File System View Tool Help A VMS-4200 oot @R 164545 @ - o x

—
== Control Panel

Operation and Control

deleting, and basic

arm, abnormal
age aclions of the

@, L5 B e The 80 portis occupied bythe process of Skype .exe , web server will not b
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MENI
Open Captured picture Pretrazite i pregledajte uslikane kadrove sacuvane na PC-u.
Open Video File Pretrazite i pregledajte video fajlove sa¢uvane na PC-u
File
Open Log File Pregledajte Log fajl.
Exit Izadite iz iVMS-4200 klijent programa.
Lock Zakljucajte opcije na ekranu. Ulogujte se za otklju¢avanje.
Switch User Ulogujte se sa drugim nalogom — promenite nalog.
System
Import System Config File Ucitajte klijentski konfiguracioni fajl sa racunara.
Export System Config File Izvezite klijentski konfiguracioni fajl na rac¢unar.
1024*768 Otvorite prozor u rezoluciji 1024*768 pixela.
1280*1024 Otvorite prozor u rezoluciji 1280*1024 pixela.
1440*900 Otvorite prozor u rezoluciji 1440*900 pixela.
1680*1050 Otvorite prozor u rezoluciji 1680*1050 pixela.
Full Screen Otvorite prozor u ,full screen” modu.
View
Control Panel Pristupite Kontrol Panel stranici.
Main View Otvorite stranicu za prikaz slike sa kamera.
Remote Playback Otvorite stranicu za pregled snimaka.
E-map Otvorite stranicu sa E-mapama.
Auxiliary Screen Preview Otvorite , Auxiliary” prozor .
Device Management Otvorite stranicu za rad sa uredajima.
Event Management Otvorite stranicu za rad sa dogadajima.
Record Schedule Otvorite stranicu za podesSavanje snimanja.
Account Management Otvorite stranicu za rad sa nalozima.
_ Log Search Otvorite stranicu za pretragu logova.
00
System Configuration Otvorite stranicu za konfiguraciju sistema.
Broadcast Izaberite kameru sa koje Zelite da po¢ne emitovanje.
Device Arming Control Podesite status aktivacije uredaja.
1/0 Control Ukljucite/iskljucite alarmne izlaze.
Player Otvorite plejer za pustanje video fajlova.
Message Queue Prikaz informacija o E-mailovima koji treba da se posalju.
Open Wizard Otvorite ¢arobnjaka za konfiguraciju klijentskog programa.
User Manual (F1) Otvorite korisnicko uputstvo; moZete ga _otvoriti i pritikom na
taster F1 na tastaturi.
Help
About Pregled osnovnih informacija o klijentskom programu.
Izaberite jezik koji Zelite da koristite i restartujte aplikaciju
Language R N .
kako bi ucitali nova podesavanja.
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iVMIS-4200 klijentski softver sastoji se od sledeéih funkcijskih modula:

pa220024
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y

Main View modul obezbeduje uzivo sliku sa mreznih kamera, video enkodera i podrzava
osnovne operacije kao $to su , picture capturing”, snimanje, PTZ controlu itd.

Remote Playback modul obezbeduje pretragu, reprodukciju i eksport snimljenih fajlova

E-map modul obezbeduje prikazivanje i upravljanje E-mapama, alarmnim ulazima , “hot
region-ima” i “hot spot-ovima”.

Device Management modul obezbeduje dodavanje, modifikacijui brisanje razlicitih
uredaja. Takode omogucava importovanje uredaja u grupe.

Event Management modul obezbeduje podesavanja koja se odnose na naoruzavanje
alarmnih sistema, povezivanje alarma sa odredenim akcijama, podesavanje ostalih
parametara za razli¢ite dogadaje.

Record Schedule modul obezbeduje podesavanja rasporeda snimanja.

Account Management modul obezbeduje dodavanje, modifikaciju i brisanje korisnickih
naloga i definisanje prava pristupa i dozvole za odredeni korisnicki nalog.

Log Search modul obezbeduje pretragu sistemskih log fajlova po razli¢itim tipovima.

System Configuration modul obezbeduje konfiguraciju opstih parametara, podesavanje
lokacije za skladistenje snimljenih fajlova, podesavanje zvuka za alarme i ostala sistemska
podesavanja

Funkcijskim modulima lako se pristupa klikom na navigacione tastere u okviru kontrolnog panela ili
odabirom modula iz View i Tool padajucih menija.

Informacije o trenutno ulogovanom korisniku, stanju mreze, iskoris¢enju procesora, memorije i
vremenu moZete videti u gornjem desnom uglu u okviru glavne stranice.
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2. Uzivo prikaz - Live View

2.1 Registracija korisnika i prijavljivanje

Prilikom prvog pokretanja iVMS-4200 klijentskog programa, potrebno je kreirati “super user” nalog.

Koraci:
1. Unesite ,super user” ime i Sifru.
2. Potvrdite Sifru.
3. Opciono, obeleZite opciju Enable Auto-login kako biste se prijavljivali na program automatski.
4. Kliknite na Register. Nakon toga se mozZete prijaviti u program kao “super user”.
Register Administrator
Please create a super user before proceeding
Super User: [l |
Password:
Confirm Password
Enable Auto-login
Reagister Cancel
Napomena:
®  Korisni¢ko ime ne sme sadrzati sledeée karaktere: /\: *? “ <> |
® Polje Sifra ne sme biti prazno niti krace od 6 karaktera

Prilikom otvaranja iVMS-4200, a nakon registracije, moZete se ulogovati na klijentski program uz
pomoc registrovanog korisnickog imena i Sifre.

Koraci:

1. Unesite korisnicko ime i lozinku koje ste prethodno registrovali.

2. Opciono, obeleZite opciju Enable Auto-login kako biste se prijavljivali na program automatski.
3. Kliknite na Login.

User Mame: | root

Password:

Enable Auto-login

Login

Cancel

Nakon pokretanja klijentskog programa, iskocice carobnjak koji ¢e Vas voditi kroz osnovna podesavanja
uredaja.
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2.2 Dodavanje uredaja

Nakon pokretanja iVMS-4200, uredaji poput IP kamera, video enkodera, DVR/NVR uredaja, trebali bi
da se dodaju kao klijenti za potrebe udaljenog pristupa i podesSavanja, poput prikaza Zive slike,
reprodukcije, alarm podesavanja, itd.

Ispratite sledece korake kako biste pristupili delu za dodavanje novih uredaja:

1. Kliknite na ikonicu B8 u kontrol panelu, ili kliknite na Tools->Device Management da otvorite
stranicu za rad sa uredajima.

2. Kliknite na Server karticu.

3. Kliknite na Encoding Device da pristupite interfejsu za dodavanje uredaja.

= rver & Group
Organization Deuice for Management (2)
_ Add Device Modify Delete Remote Config Refresh All Filter
Add New Device Type Nickname = |IP Device Serial No. Net Status HDD Status Recording
Online Device (8) Refresh Every 155
Add to Client AddAll Modify Netinfo Restore Default Password Filter

P 4 | Device Type Port Device Serial No. Added
172623123 DS-20D21324 8000 DS-2CD2132-10120130426CCRRA43221284 No

e 172623105  DS-2CD864F-ED 8000  iDS-2CDBBAF-E/D0120130307CCRRA17674726  No
DVR/DVSINVRIPC/IPDAVNS-4200 | ‘

FCNVRIVHIS 4200 Encoding Sever || 172623477 DS-2CD8464C-CV1 8000  DS-2CD8464C-CV10120130121CCRR416186816  No

Uredaj moZete dodati na sledece nacine:

Detektovanjem online uredaja, objasnjeno u sekciji 2.2.1
Manuelno dodavanje IP adrese uredaja, objasnjeno u sekciji 2.2.2.
Manuelno dodavanje IP segmenta, objasnjeno u sekciji 2.2.3.

Uz pomoc IP Servera, objasnjeno u sekciji 2.2.4.

Uz pomo¢ HiDDNS servisa, objasnjeno u sekciji 2.2.5.

2.2.1 Dodavanje Online uredaja

Aktivni online uredaji koji se nalaze u istom lokalnom subnet-u uz pomo¢ ovog programa biée prikazani
na listi. Kliknite na Refresh Every 15s taster kako biste osvefZili informacije o online uredajima.

Koraci:

1. Oznadite uredaj sa liste koji Zelite da dodate.

Kliknite na Add to Client kako biste otvorili prozor za dodavanje uredaja.
3. Unesite neophodne informacije.

Nickname: Unesite naziv po kome éete raspoznavati uredaj.

Address: Unesite IP adresu uredaja.
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Port: Unesite port za pristup uredaju. Podrazumevani port je 8000.
User Name: Unesite korisni¢ko ime za pristup opremi. Podrazumevano korisni¢ko ime je admin.
Password: Unesite Sifru za pristup uredaju. Podrazumevana Sifra je 12345.

4. Opciono, mozete obeleziti stavku Export to Group kako biste kreirali grupu po imenu uredaja. Svi
kanali uredaja ¢e biti uvezeni u odgovarajuce grupe po default-u.
5. Kliknite na Add da dodate uredaj.

Adding Mode:

@ |P/Domain IP Segment IP Server HIDDNS

Add Offline Device

Nickname: [|

Address 172.6.23.124
Port. 8000
User Mame:

Password
+ Exportto Group

Setthe device name as the group name and add all the channels
connected to the davice to the group.

Add Cancel

Kliknite na Add All, unesite korisni¢ko ime i lozinku, potvrdite na Add i unecete sve online - aktivne
uredaje u klijentski program.

Add *

Adding Mode
% IPiDomain IP Segment IP Server HIDDNS

User Name [\

Password

~ Exportto Group

Create group with device IP.

Add Cancel

Izaberite uredaj sa liste, kliknite na Modify Netinfo, i moZete modifikovati informacije o izabranom
uredaju.

Izaberite uredaj sa liste, kliknite na Restore Default Password, i na taj nacin mozete vratiti Sifru na
podrazumevanu vrednost, 12345.
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2.2.2 Dodavanje uredaja rucno

Koraci:

1. Kliknite na Add Device da otvorite prozor za dodavanje uredaja.

2. lzaberite IP/Domain kao mod za dodavanje uredaja.

3. Unesite neophodne informacije.
Nickname: Unesite naziv po kome ¢ete raspoznavati uredaj.
Address: Unesite IP adresu uredaja ili ime domena.
Port: Unesite port za pristup uredaju. Podrazumevani port je 8000.
User Name: Unesite korisni¢ko ime za pristup opremi. Podrazumevano korisni¢ko ime je admin.
Password: Unesite Sifru za pristup uredaju. Podrazumevana Sifra je 12345.

4. Opciono, moZete obeleziti stavku Export to Group kako biste kreirali grupu po imenu uredaja. Svi
kanali uredaja ¢e biti uvezeni u odgovarajuce grupe po default-u.

5. Kliknite na Add da dodate uredaj.

Adding Mode

@ IP/Domain IP Segment IP Server HIDDNS

Add Offline Device

Nickname
Address
Port: 8000

User Name:

Password
~/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel

2.2.3 Dodavanje uredaja po IP Segment-u

Koraci:

1. Kliknite na Add Device da otvorite prozor za dodavanje uredaja.

2. lzaberite IP Segment kao mod za dodavanje uredaja.

3. Unesite neophodne informacije.
Start IP: Unesite startnu IP adresu.
End IP: Unesite poslednju IP adresu koja ¢e biti u istom mreZznom segmentu kao startna.
Port: Unesite port za pristup uredaju. Podrazumevani port je 8000.
User Name: Unesite korisni¢ko ime za pristup opremi. Podrazumevano korisni¢ko ime je admin.
Password: Unesite Sifru za pristup uredaju. Podrazumevana sifra je 12345.

4. Opciono, moZete obeleziti stavku Export to Group kako biste kreirali grupu po imenu uredaja. Svi
kanali uredaja ¢e biti uvezeni u odgovarajuce grupe po default-u.

5. Kliknite na Add da dodate ureda;j.

10
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Adding Mode

IPIDomain @ |P Segment IP Server HiDDMS

Add Offline Device

Start IP [I

End IP
Port: 8000
User Name:

Passwaord:
+ Exportto Group
Create group with device IP.

Add Cancel

2.2.4 Dodavanje uredaja po IP Server-u

Koraci:
1. Kliknite na Add Device da otvorite prozor za dodavanje uredaja.
2. lzaberite IP Server kao mod za dodavanje uredaja.
3. Unesite neophodne informacije.
Nickname: Unesite naziv po kome éete raspoznavati uredaj.
Server Address: Unesite adresu IP Server-a.

Device ID: Unesite ID uredaja registrovanog IP server-u.

User Name: Unesite korisni¢ko ime za pristup opremi. Podrazumevano korisni¢ko ime je admin.

Password: Unesite Sifru za pristup uredaju. Podrazumevana Sifra je 12345.

4. Opciono, moZete obeleZiti stavku Export to Group kako biste kreirali grupu po imenu uredaja. Svi
kanali uredaja ¢e biti uvezeni u odgovarajuce grupe po default-u.
5. Kliknite na Add da dodate ureda;j.

Adding Mode

IP/Domain IP Segment 2 P Server HiDDMS

Add Offline Device

Nickname: [|

Server Address
Device ID:
User Name:

Password:
-/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group

Add Cancel

11
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2.2.5 Dodavanje uredaja preko HiDDNS

Koraci:

1. Kliknite na Add Device da otvorite prozor za dodavanje uredaja.
2. Unesite HiDDNS kao mod za dodavanje uredaja.

3. Unesite neophodne informacije.
Nickname: Unesite naziv po kome Cete raspoznavati uredaj.
Server Address: www.hik-online.com.
Device Domain Name: Unesite ime domena koji ste registrovali na HiDDNS server-u.
User Name: Unesite korisni¢ko ime za pristup opremi. Podrazumevano korisni¢ko ime je admin.
Password: Unesite Sifru za pristup uredaju. Podrazumevana Sifra je 12345.

4. Opciono, moZete obeleziti stavku Export to Group kako biste kreirali grupu po imenu uredaja. Svi
kanali uredaja ¢e biti uvezeni u odgovarajuce grupe po default-u.
5. Kliknite na Add da dodate ureda;j.

Add x

Adding Mode

IP/Domain IP Segment IP Semver #* HIDDMS

Add Offline Device

Nickname: [

Server Address www.hik-online.com

Device Domain Name:

User Name:

Password:
+ Exportto Group

Set the device name as the group name and add all the channels
connected to the device to the group

Add Cancel

Napomena: iVMS-4200 takode podriava metod dodavanja offline uredaja . Cekirajte polie Add
Offline Device, unesite odovarajuce parametre, a potom kliknite na opciju Add. Kada offline uredaj
prede u online stanje, program ¢e se automatski povezati sa njim.

Nakon uspesnog ubacivanja uredaja, isti ¢e biti dodat na listu. Tu moZete proveriti potroSnju resursa,
status HardDisk-a, status snimanja i ostale informacije vezane za uredaje na listi.

Kliknite na Refresh All kako biste osvezZili informacije o svim dodatim uredajima. Uredaj moZete
pronadi i kroz search polje.

Izaberite uredaj sa liste, kliknite na Modify/Delete, i moZete menjati i brisati informacije o
selektovanom uredaju.

Izaberite uredaj sa liste, kliknite na Remote Config, i mozZete daljinskim putem pristupiti uredaju i
vrsiti podesavanja.

12
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2.3 Podesavanje grupa pregleda

Zbog lakSeg administriranja ubacite uredaje u grupe. Dobiéete mogucnost prikaza Zive slike, moguénost
reprodukcije snimljenih fajlova i ostale operacije za rad sa uredajima koje moZete raditi kroz grupu.

Pre nego pocnete:

Pre podeSavanja grupa uredaji moraju da se dodaju u klijentski program.

Ispratite sledece korake kako biste pristupili delu za podeSavanje grupa:
1. Otvorite Device Management stranicu.

2. Kliknite na Group karticu kako biste pristupili interfejsu za podesavanje grupa.

Z  sener & Group
JAddGroup i Delete Group Resources of Group IPC1
Search 2 Import Mogif Delete Remote Config Filter

Nickname ~|IP Device Serial No.

2.3.1 Dodavanje grupe

Koraci:

1. Kliknite na Add Group kako biste otvorili prozor za dodavanje.
2. Unesite ime grupe.

3. Kliknite na OK kako biste dodali novu grupu na listu.

Takode mozete obeleziti polje Create Group by Device Name kako biste kreirali novu grupu po
imenu selektovanog uredaja.

Add Group x

Group Name: ﬂ 1

Create Group by Device Name

oK Cancel

2.3.2 Dodavanje uredaja/kanala u grupu

Koraci:

1. Kliknite na Import u okviru dela za podesSavanje grupa, a zatim na Encoding Channel kako biste
otvorili prozor za dodavanje kanala.

2. Odaberite slike/imena kanala sa liste.
3. Odaberite grupu sa liste.
4. Kliknite na Import kako biste ubacili selektovane kanale u izabranu grupu.

Mozete kliknuti i na Import All da dodate sve kanale u odabranu grupu.

Napomene:

® Mozete takode kliknuti na ikonicu u okviru Encoding Channel stranice da dodate novu grupu.
® Do 64 kamera moZe biti dodato u grupu.
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Import

nannel | M Alam input

Seled Device Al

Encoding Channel

IFC1

IPC2
OVR L 4|
-

impart

IMpORAIl

Group

Slededi tasteri su dostupni na Encoding Channel stranici:

== List View

] Thumbnail View
i Refresh

S

=~ Import

Pregled kanala u vidu liste.
Pregled kanala u vidu slika.
Osvezavanje informacija o kanalima.

Kreiranje grupe po imenu uredaja i dodavanje uredaja u grupu.

Collapse/Expand Smanijiti/povecati prikaz slika i liste.

2.4 Osnovne operacije u Live View (uzivo pregled) rezimu

Za potrebe video nadzora mozete vrsiti pregled kamera i DVR uredaja na stranici Main View.
ukljucene i dodatne opcije, uslikavanje kadra, manuelno snimanje, PTZ kontrola, itd.

Kliknite na ‘ ikonicu u okviru kontrolnog panela

i kliknite na View->Main View kako biste otvorili Main View stranicu.

Main View stranica 1

1 Tip prikaza kamera
2 Lista kamera
3 PTZ Kontrolni Panel

4 Displaj prikaza slike sa
kamere

5 Linija sa dostupnim
alatkama - toolbar

O 1-gereen

[ 2-serean

Takode su

14
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Status kamere:

@ Kamera je aktivna i funkcionise ispravno.

6 Pusten uZivo prikaz sa kamere — Live View.
('-‘ Kamera je u stanju snimanja.

"e Kamera je nedostupna - offline.

Live View Toolbar - alatke:

Na stranici Main View, dostupne su sledece opcije:

Set View

Previous

Next

B

OE® B OGO E
=

Full Screen

Stop Live View

Resume/Pause

Auto-switch
Show /Hide the Menu

Mute/Audio On

Podesite Semu za prikaz Zive slike sa kamera;

saCuvajte trenutnu Semu kao novu Semu.
Zaustavite prikaz sa kamera.
Vratite se na Live prikaz prethodne stranice.

Prebacite se na Live prikaz sledece stranice

Kliknite na ikonice kako biste pokrenuli auto rotaciju kamera.

Prikazi/ Sakrij podeSavanja auto rotacije kamera.

Iklju¢ite/ukljucite audio u live view modu.

Prikaz uZivo snimka u full screen modu. Kliknite na ESC za izlaz.

Desnim klikom na neki od prozora za prikaz slike sa kamera otvara se meni za dodatna podesavanja:

= Stop Live View

@i Capture
(=) Print Captured Picture
% Send Email
© startRecording
2. Open Window PTZ Control
&_ Open Digital Zoom
@ switch to Instant Playback

 Start Two-way Audio
w) Disable Audio

| Camera Status
s Remote Configuration
L Synchronization

25 Full Screen

15
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U meniju su dostupna sledeéa podesavanja:

i g m

@ Pk 0

Al
i

w2 W

Stop Live View
Capture

Print Captured Picture

Send Email

Start/Stop Recording
Open Window PTZ
Control

Open Digital Zoom
Switch to Instant

Playback
Start/Stop Two-way
Audio

Enable/Disable Audio

Camera Status

Remote Configuration
Synchronization
Full Screen

Stopiranje uzivo prikaza.
Uslikavanja kadra u toku Zivog prenosa slike.

Uslikavanja kadra i Stampanje na dostupnim Stampacima.

Uslikavanja kadra i slanje Emaila na jednu ili viSe mail adresa. Po
potrebi se moze poslati i uslikan kadar u vidu slike.

Start/Stop the manual recording. The record file is stored in the PC.
Enable PTZ control function on the display window. Click again to
disable the function.

Enable the digital zoom function. Click again to disable the function.

Switch to instant playback mode.

Click to start/stop the two-way audio of the camera in live view.

Click to enable/disable the audio in live view.

Display the status of the camera in live view, including the recording

status, signal status, connection number, etc.

Open the remote configuration page of the camera in live view.
Sync the camera in live view with the PC running the client software.
Display the live view in full screen mode. Click the icon again to exit.

2.4.1 Pokretanje i stopiranje ,Live View" prikaza

Pokretanje , Live View“ prikaza na jednoj kameri

Koraci:

1. Otvorite Main View stranicu.

2. Opciono, kliknite na ikonicu u delu sa alatkama, a nakon toga izaberite Semu za prikaz
slika kamera.

3. Kliknite na Zeljenu kameru i prevucite je u prozor, odaberite prozor za prikaz kamere i
nakon toga odradite dupli klik na kameru Ciji prikaz slike Zelite.

Napomena: Ukoliko Zelite da promenite raspored kamera u prozoru za prikaz, kliknite na prozor koji
Zelite da pomerite, zadrzite levim klikom misa i prevucite na Zeljenu poziciju.

16
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Pokretanje , Live View" prikaza za grupu kamera

Koraci:

1. Otvorite Main View stranicu.

2. Kliknite na grupu kamera i prevucite je u prozor, ili kliknite na ime grupe kako biste pokrenuli prikaz
slike sa svih kamera iz grupe.

Napomena: Displej se automatski podesava, a u zavisnosti od broja kamera u grupi.

Stopiranje ,Live View" prikaza

Koraci:

1. lzaberite prozor kamere ¢iji prikaz slike Zelite da zaustavite.

2. Kliknite na ikonicu . u gornjem desnom uglu , ili desnim klikom na prikaz slike iz menija
odaberite opciju Stop Live View .

MozZete kliknuti i na ikonicu D u delu sa alatkama/ toolbar-u.
2.4.2 Auto prebacivanje prikaza sa kamera u ,Live View"“ modu

Automatko prebacivanje prikaza sa kamera (Switch rezim)
Video slika sa kamera u istoj grupi rotira se automatski u selektovanom prozoru za prikaz slike.

Koraci:

1. Otvorite Main View stranicu.

2. lzaberite prozor u kome Zelite da se kamere rotiraju.

3. Kliknite na ikonicu I u okviru linije sa alatkama i izaberite interval u kome se kamere rotiraju.
4. lzaberite grupu kamera i kliknite na vJ ikonicu pored fascikle sa kamerama.

5. Mozete kliknuti na ikonice /E da pauzirate/ nastavite auto rotiranje kamera.

17
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2.4.3 PTZ Kontrola u okviru ,Live View" prikaza

Program obezbeduje PTZ kontrolu za kamere koje imaju ovu funkcionalnost. Otvorite PTZ kontrolni
panel klikom na ikonicu #% kako biste izvrsili podeSavanja i upravljali odredenim kamerama.

U okviru PTZ Kontrolnog panela dostupne su sledeée opcije: PTZ Contral

L
Q v a v + QO -
Zumiranje dol-l+lal-
d - v 4 + & -
Fokus - +
0 Iris ZE e
r'1
L'a AuxFokus Preset | Pattem | Patrol
3D pozicioniranje > & M
L Osvetljenje 01 Preset! |
4 02 Preset2 ‘ |
Wiper L
P 03 Presets
| ol |
L J Inicijalizacija objektiva 04 Presetd

2.4.4 Ru¢no snimanje i uslikavanje kadra

Linija sa alatkama u okviru svakog prozora:

U okviru svakog prozora dostupna je Inija sa alatkama koja nudi sledece opcije:

-~ Capture Uslikavanje kadra u toku Zivog prikaza slike.

- . - . . . - Y . .
u Start/Stop recording  Pokrenite i zaustavite snimanje. Snimci su sacuvani na raunaru.

Switch to Instant

Pokrenite snimljeni materija.
Playback ! )

Rucno snimanje u okviru Live View moda

Opcija ru¢nog snimanja daje Vam mogucénost ru¢nog snimanja uzivo prikaza u okviru Main View
stranice. Fajlovi se ¢uvaju lokalno, na racunaru.
Koraci:

1. Predite miSem preko ekrana kamere Ciji prikaz Zelite da snimite. Pojavic¢e Vam se linija sa alatkama.
2. Kliknite na e ikonicu u okviru linije sa alatkama ili na Live View Management Meni
kako bist startovali snimanje. lkonica preci¢e u stanje MG

I - = . Sy . .
3. Kliknite na ikonicu kako biste zaustavili ru¢no snimanje.
Kada zaustavite snimanje u donjem desnom uglu iskoci¢e prozor sa informacijom o lokaciji na

kojoj se nalazi snimljen fajl.
Napomene:

® Tokom ruénog snimanja, indikator ﬁ pojavice se u gornjem desnom uglu prozora.
18
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Pregled lokalno snimljenih fajlova

Koraci:

1. Kliknite na File->Open Video File kako biste otvorili stranicu snimljenih fajlova.
2. lzaberite kameru Cije snimljene fajlove Zelite da pretrazite.

3. Kliknite na ikonicu ﬂ kako biste odredili interval pretrage.

4,

Kliknite na Search. Video fajlovi snimljeni u intervalu koji ste izabrali bi¢e prikazani.
Obelezite video fajl, kliknite na Delete kako biste obrisali fajl.

Obelezite video fajl, kliknite na Email Linkage. Na ovaj na¢in moZete poslati Email obavestenje sa

zakacéenim video snimkom.

Obelezite video fajl, kliknite na Save as. Na ovaj nacin ¢ete sacCuvati video fajl na odredeno mesto.

Napomena: Ukoliko koristite opciju slanja snimka putem mail-a, prethodno podesite mail opciju u

okviru programa.

Camera Group Video Files @ Delete Email Linkage(Max.=5MB) = Save as
Search. p
= IPct

& IPC1_Camera01
- JIPc2

- _J IPDome

& 1P Dome_Cameral| |
= I NVR1

& NVR1_IP Cameral

& NVR1_IP Camera2

& NVR1_IPCamera

& NVR1_Camera01

& NVR1_IP Camera5 _

Start Time:
2013-04-24 00:00:00 [
End Time:

2013-04-24 23:59:59 ied

Q search

Duplim klikom na snimak, moZete ga pregledati lokalno.

19



HikVision iVMS-4200 korisnicko uputstvo — SECTRON d.o.o Beograd

Player

OoOoos OE

00:00:09/00:03:08

Pokretanjem snimka plejer nudi sledeée opcije:

. . CIF/4CIF Prikaz snimka u cif/4cif rezoluciji.

n Full Screen Prikaz snimka u full screen modu.

n Close Taster kojim zatvarate plejer/stranicu.

n n Pause/Play Pauzirajte/pustite snimljeni fajl.

n Stop Stopirajte snimak.

n Speed Podesite brzinu snimka.

n Single Frame Pregled snimka frejm po frejm.

Digital Zoom Digitalni zum. Jo$ jedan klik da prekinete zum.

n n Enable/Disable Audio Omogucite/onemogudite zvuk na snimku.

Capture Uslikavanje kadra u toku trajanja snimka.

Uslikavanje kadra u toku ,,Live View" prikaza

Koraci:

1. Predite miSem preko ekrana. Pojavice Vam se linija sa alatkama.

-
2. Kliknite na ikonicu u delu sa alatkama ili odradite desni klik na ekran kako biste dobili Live
View meni i istu Capture ikonicu.

Nakon klika na ikonicu u donjem desnom uglu pojavice se kadar koji ste uslikali sa informacijom
gde je slika smestena i da li je kadar pravilno uslikan.

Napomena: Lokacija na kojoj se ¢uvaju uslikani kadrovi posebno se podesava u delu System
Configuration/File Saving Path Settings.
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Pregled uslikanih kadrova

Uslikani kadrovi nalaze se snimljeni lokalno na racunaru. MoZzete ih pregledati po potrebi.

Koraci:

1. Kliknite na File->Open Captured Picture kako biste otvorili stranicu sa uslikanim kadrovima.
2. Odaberite kameru ¢ije kadrove Zelite da pregledate.

3. Kliknite na ikonicu ﬂ kako biste odredili interval pretrage.

4. Kliknite na Search. Kadrovi uslikani u intervalu koji ste izabrali bice prikazani.

5. Dupli klik na sliku i uvecacete prikaz slike radi boljeg pregleda.

Izaberite opciju Print ukoliko Zelite da odStampate sliku.

Izaberite opciju Delete da obrisete sliku.
Izaberite opciju Email Linkage ukoliko Zelite da po3aljete sliku putem mail-a.
Izaberite opciju Save as da sacuvate sliku na odredenu lokaciju.

Open Captured Picture x

Camera Group Local Capture = Print © Delete || [ Emall Linkage(Max=5MB), | = Save as
Search. P

= S Pc

&) IPC1_Cameral
= &5 IPc2

+ LI DVR

Start Time:
2013-05-09 00:00:00 e
End Time:

2013-05-09 23:59:59 el

Q, search
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2.4.5 Trenutna - Instant reprodukcija
Koraci:

1. Pokrenite uZivo prikaz i prevucite misem reko ekrana kako bi se pojavila linija sa alatkama.
Ty
2. Kliknite na ikonicu u liniji sa alatkama i pojavice se vremenski periodi.
30sek, 1 min, 3 min, 5 min, 8 min, i 10 min su dostupni periodi.
3. lzaberite vremenski period kako biste zapoceli reprodukciju.

Primer: Ako je trenutno vreme 09:30:00, a Vi izaberete period 3 min, instant reprodukcija ¢e
poceti od 09:27:00.

Ty
1. Kliknite na ikonicu opet da zaustavite reprodukcijui vratite na Zivi prkaz slike.

Napomene:

® Tokom instant reprodukcije, pojavice se indikator E u gornjem desnom uglu prozora.
®  7Zivi prikaz slike nastavice se posle zavréetka snimka.
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Desnim klikom u prozoru otvara se Instant Playback Management meni:

s Pause

= Stop

»» SpeedUp

<« Speed Down
Single Frame
Open Digital Zoom

Capture

Print Captured Picture
Send Email

© Start Recording

(&2 Enable Audio

¢/ B Lo s

@ Switch to Live View

&5 Full Screen

U meniju su dostupne sledece opcije:

i

HOL O i B EE

=

=)

Pause/Play
Stop
Speed Up/Down

Single Frame

Open Digital Zoom

Capture

Print Captured Picture
Send Email

Start/Stop Recording

Enable/Disable Audio
Switch to Live View
Full Screen

Pauzirajte/pokrenite snimak.
Zaustavite snimak i vratite se u Live View mod.
Ubrzajte/usporite brzinu snimka.

Reprodukujte snimak frejm po frejm.

Omogucite digitalni zum. Kliknite josS jednom da iskljucite.

Uslkajte kadar u toku reprodukcije.

Uslikajte kadar i odStampajte sliku.
Uslikajte kad ar i po3aljite jednoj ili na viSe mail adresa.

Pokrenite/Stopirajte snimanjedela snimka .

Isklju¢ite/ukljucite audio ton.
Prebacite se na live view mod.

Pustite snimak u full screen modu.
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3. Reprodukcija

3.1 Daljinska - Remote reprodukcija

Kliknite na ikonicu u okviru kontrolnog panela,

Ilina View->Remote Playback kako biste otvorili Remote Playback stranicu .

11—

Camar=

Cuen:

Wodisn Deteclian
P

- ez

L3 L DVR

Aamirpat

3 Llore Scarch Uphions
Frorm 3013-0500 03:00:00
0 R0 02 LY 23U

Sezith

4

seaen Hesut

Remote Playback Stranica
1 Lista pregleda, kamera i dogadaja
2 Kalendar
3 Pretraga
4 Rezultati pretrage
5 Prozor za prikaz snimka
6 Linija sa alatkama

7 Timeline — vremenska linija
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3.1.1 Normalna reprodukcija

Snimljeni fajlovi mogu da se pretrze po kameri, alarmu ili dogadaju radi reprodukcije.

Pretraga snimaka

Koraci:

1. Otvorite Remote Playback stranicu.

2. Kliknite naikonicu = da prosirite listu dogadaja sa leve strane.
Kliknite na Motion Detection ili Alarm Input, i izaberite kamere ili alarmne senzore.

Na kalendaru izaberite dan koji Zelite da pretrazite.

L'} um
Mozete takode da kliknete na * da prikazete vise opcija pretrage, a zatim na ikonicu t..E da
blize odedite startni i krajnji datum pretrage.

5. Kliknite na Search. Snimci sa selektovanih kamera, alarmnih senzora, a u okviru zadatog
vremenskog intervala biée prikazani na listi.

Napomene:

® Snimljene fajlove moZete pretrazivati i po broju kartice (dostupno za ATM DVR) ili po tipu fajla.

®  Ukoliko postoji snimak za kameru u tom danu, u kalendaru, ikonica ¢e biti oznacena 2.U

suprotnom izgledade ]

® 16 kamera moZe da se pretraZuje simultano.

Search Result ~

Filter

- @ IPC1_Cameral
ﬁ 2013-05-09 09:12:02
ﬁ 2013-05-09 10:06:13
ﬁ 2013-05-09 11:04:50
ﬁ 2013-05-09 11:58:35
ﬁ 2013-05-09 12:44:29
B 2013-05-00 133312
ﬁ 2013-05-09 14:13:18

Normalna Reprodukcija

Nakon pretrage snimaka koji su zabeleZeni na odredeni dogadaj, iste moZete pustiti na dva nacina:

® Reprodukcija sa liste

Odaberite snimljeni fajl sa liste, kliknite na ikonicu u , ili odradite dupli klik na video
kako biste ga pokrenuli.

® Reprodukcija sa ,Timeline“-a
Timeline — vremenska linija prikazuje duZinu trajanja snimka. Kliknite na vremensku liniju kako

biste pustili snimak od odredenog trenutka.
MozZete kliknuti na == i|i IE===8 da povecate ili smanjite vremenski period na vremenskoj liniji

(5min, 30min, 1h). Klikom na ikonice L2 /L% Iprepazite na slededi ili se vracate na prethodni period.
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Linija sa alatkama:

Napomena: Mozete kliknuti na slajder u okviru linije sa alatkama kako biste podesili brzinu
reprodukcije snimka.

Snimci po dogadaju

Snimanje pokrenuto zbog detekcije pokreta ili aktivacije alarma moze biti pretrazeno radi dalje
reprodukcije snimaka.

Pretraga snimaka po dogadaju

Koraci:
Otvorite Remote Playback stranicu.

1
2. Kliknite naikonicu & da prosirite listu dogadaja sa leve strane.

3. Kliknite na Motion Detection ili Alarm Input, i izaberite kamere ili alarmne senzore.
4

Na kalendaru izaberite dan koji Zelite da pretrazite.

Mozete takode da kliknete na * da prikaZete vise opcija pretrage, a zatim na ikonicu EE da
bliZze odedite startni i krajnji datum pretrage.

5. Kliknite na Search. Snimci sa selektovanih kamera, alarmnih senzora, a u okviru zadatog
vremenskog intervala bice prikazani na listi.

3.1.2 Reprodukcija snimaka dogadaja - Event Playback

Nakon pretrage snimaka koji su zabeleZeni na odredeni dogadaj, iste moZete pustiti na dva nacina:

® Reprodukcija sa liste

Odaberite snimljeni fajl sa liste, kliknite na ikonicu , ili odradite dupli klik na video
kako biste ga pokrenuli.
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® Reprodukcija sa , Timeline“-a
Timeline — vremenska linija prikazuje duzinu trajanja snimka. Kliknite na vremensku liniju kako biste
pustili snimak od odredenog trenutka.
Mozete kliknuti na ==l il IE===l da povecate ili smanjite vremenski period na vremenskoj liniji
(5min, 30min, 1h). Klikom na ikonice .. /L%lprepazite na sledeiili se vracate na prethodni period.
Linijja sa alatkama:

Na stranici Remote Playback, dostupne su sledece opcije:

E Stop Playback Zaustavljanje snimka sa svih kamera.

m Pause/Start Playback Pauzirajte/Startujte snimak.

Single Frame Pustite snimak frejm po frejm.

. Previous Event Pustite prethodni dogadaj.

. Next Event Pustite sledeci dogadaj.

mm Volume Onemogucite i ponovo pustite audio snimak.

Full Screen Pustite video snimak u full screen modu. Kliknite na ESC za izlaz.

Mozete kliknuti na slajder u okviru linije sa alatkama kako biste podesili brzinu reprodukcije snimka.

3.1.3 Sinhrona reprodukcija

Kod sinhrone reprodukcije, snimljeni fajlovi mogu da se puste sinhrono.

Napomena: Snimljeni fajlovi sa 16 kamera mogu da se puste u istom trenutku simultano.

Sinhrona reprodukcija sa pretrazenih kamera

Koraci:
1. Pokrenite normalnu reprodukciju sa pretrazenih kamera.
i ——
2. Kliknite na ikonicu u okviru linije sa alatkama, kako biste sinhronizovali snimke. lkonica I
——
preci ¢e u Imal .
3. Da zaustavite sinhronu reprodukciju, kliknite na ikonicu sl .
Sinhrona reprodukcija sa svih pretrazenih kamera
Koraci:
1. Pokrenite normalnu reprodukciju sa pretrazenih kamera.
o -
2. Kliknite na ikonicu u okviru linije sa alatkama, kako biste sinhronizovali snimke. Ikonica lms
——
preci e u md .
3. Selektujte snimljene fajlove sa liste i kliknite na ikonicu .
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4. Informacije o alarmima i dogadajima

4.1 Pregled informacija o alarmima i dogadajima

Moguce je pregledati informacije o skorasnjim alarmima i dogadajima. Kliknite na ikonicu E u okviru
linije sa alatkama i pojavice se panel za prikaz alarma i dogadaja.

) & EI = Wotion Detection Alarm Stop
Index¥ | Alarm Time Alarm Source Alarm Details Alarm Content Live View | Send Email | TV Wall Display | Note
2 2013-03-27 19:48:25 Encoding Device:lPC Camera: IPC_Camera1 Tampering Alarm Stop | )
19:48:15 Encoding Device:IPC Camera: IPC_Camera1 Tampering Alarm Start

327 19:48:14  Encoding Device:lPC  Camera: IPC_Camera1 Trig... Motion DetectionAlarm Start @ ]

m  Motion Detection + Video Exception v Alarm Input  Device Exception

Na panelu dostupne su sledeée opcije:

E Clear Info Brisanje informacija o alarmima prikazanim na slici.

Enable/Disable Alarm
@ Tri dp | Kliknite na ikonice da iskljucite prozor sa informacijama kada se
riggered Fop-up Image dogodi alarm.

m n Enable/Disable Audio  Kliknite na ikonice da iskljucite/ukljuéite audio upozorenja na alarm .

m Auto Hide/Lock Kliknite da sakrijete automatski /zaklju¢ate Alarm panel.
E Maximize Otvorite stranicu u novom tab-u.
E E Show/Hide Kliknite na ikonice da prikaZete/sakrijete Alarms/Event panel.

Pregled Alarmnih Informacija

Razliciti tipovi alarma mogu biti prikazani na panelu: Detekcija pokreta, Video problemi, Alarmni ulazi
problemi sa uredajima.

Pre nego pocnete:
Da biste pregledali informacije o alarmima, prethodno trebate da konfiguriSete dogadaje pri kojima ¢e se
alarmi javljati.

Koraci:
1. Kliknite na Alarm karticu.

2. Obelezite polje ispred razlicitih tipova alarma.
3. Kada se dogodi detekcija, ikonica ¢e blinkati. Alarmne informacije, ukljucujuci vreme, izvor,
detalje i sadrzaj bice prikazani.
Kliknite na & da biste dobili prikaz sa kamere kod koje je detektovan alarm.
Kliknite na da posaljete Email notifikaciju jednoj ili viSe mail adresa.
Kliknite na EE’ da prikazete sliku sa kamere na ,,video zid“.
4. Da obrisete alarmne informacije, kliknite na ikonicu H ,ili desni klik na alarm log, a zatim na opciju

Clear.
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Pregled informacija o dogadajima

Koraci:

1. Kliknite na Event karticu.Informacije o dogadajima, ukljucujuci vreme i detaljne opise bice prikazani.

2. Ukoliko Zelite da obriSete informacije, kliknite na ikonicu u, ili desni klik na event log, a zatim na
opciju Clear.

5. Rad sa E-mapama

5.1 Pregled Hot Spot tacaka

Koraci:

Ukoliko ste dodali mapu kliknite na Map Preview taster u okviru E-map stranice.
2. Duplim klikom na neku od hot spot tacaka prikazace se trenutna slika sa kamere.

3. Ukoliko je bilo detekcije alarma, klikom na ! ikonicu pojavice se informacije o tipu alarma
blizim informacijama, ukljucujuéi vreme alarma.

State Forest

= Highway

v
+
ot T R Roxbury

Plattekil
State Forest

1
®

. .
Noddie Balsam Lake Tivok
Mountain Mountain (’j y o
Wikd Forest 2) |
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Wid Forest Wilowemoc Rh
Hurley Kingston ]
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5.2 Pregled Hot Spot regiona

Koraci:

1. Ukoliko ste dodali mapu kliknite na Map Preview taster u okviru E-map stranice.

. T " . Y
Klikom na ikonicu vracate se na pocetnu mapu.

Kliknite na hot region ikonicu kako biste se prebacili na podmapu.
Hot spot tacke se mogu dodati i u okviru podmapa.

Klikom na ikonicu u okviru linije sa alatkama briSete informacije o alarmima.
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6. Upravljanje logovima

Log fajlovi klijentskog programa cuvaju se na lokalnom racunaru i po potrebi se mogu pretrazivati.

Postoje dva tipa log fajlova. Klijentski i server log fajlovi.

Klijentski log fajlovi odnose se na logove klijenata i sacuvani su na racunaru, dok se server logovi odnose
na uredaje koji su prijavljeni u klijentski program.

Kliknite na L% ikonicu u okviru kontrolnog panela kako biste otvorili Log Search stranicu.

Log Search CiientLog Lists

® ClientLogs Operation Time

ServerLogs

Start Time:
2013-05-03 08:00:00
End Time:

2013-05-03 235859

Q, search

Total 0 Page 11

6.1 Pretraga Log fajlova

Koraci:

1. Otvorite Log Search stranicu.

~ Mame

Log Type

Description

[ LogFitter

Deice Name

Device Type

(3 Backup Log

Group Name

Page Go

2. Odaberite tip logova. U slucaju da je Server Logs odabran, definiSite dodatno uredaj.

un

3. Kliknite na ikonicu t:.& kako biste odredili vreme pocetka i zavrsetka.
Kliknite na Search. Logovi u odabranom intervalu bice prikazani na listi.
Na listi su prikazani vreme, opis i ostale informacije o logu.

Napomena: Do 36000 stavki logova je moguce prikazati. Blize definisite vreme i tip logova kako biste
suzili pretagu i smanijili broj logova koji se prikazuju.

Operation Time Name Log Type Description Device Name: Device Type Group Name
2013-05-03 08:45.:09 root Alarm Log Motion Detection A... IPC2 Encoding Device  IPC2
2013-05-03 08:46:43 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:47:30 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:47:52 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:48:16 root Alarm Log Motion Detection A_. IPC2 Encoding Device  IPC2
2013-05-03 02:49:44 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:51:03 root Alarm Log TamperingAlarm P Dome Encoding Device I Dome
2013-05-03 085103 root Alarm Log Motion Detection A IP Dome Encoding Device P Dome
2013-05-03 08:51:49 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:53:06 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:53:25 root Alarm Log Motion Detection A_. IPC2 Encoding Device  IPC2
2013-05-03 08:54:48 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:56:03 root Alarm Log Motion Detection A... IPC2 Encoding Device  IPC2
2013-05-03 08:56:05 root Alarm Log TamperingAlarm P Dome Encoding Device P Dome
2013-05-03 08:56:05 root Alarm Log Motion Detection A IP Dome Encoding Device P Dome
2013-05-03 08:57:46 root Alarm Log Motion Detection A IPC2 Encoding Device  IPC2
2013-05-03 08:58:04 root Alarm Log Motion Detection A_. IPC2 Encoding Device  IPC2
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6.2 Filtriranje Log fajlova

Nakon uspesne pretrage, log fajlove mozete filtrirati prema klju¢noj reci ili stanju i na taj nacin mozete
vrsiti pretragu na nacin koji Vam najvise odgovara.

Koraci:
1. Kliknite na Log Filter ili = na Log Search strani kako biste uvecali Log Filter panel.
2. lzaberite Filter by Keyword, a zatim unesite pojam po kome Zelite da filtrirate;

ili izaberite Filter by Condition, a zatim specifikujte pretragu odabirom neke od
ponudenih opcija iz padajuceg menija.
Opciono, mozete kliknuti na More... ukoliko Zelite pretragu po nekom drugom kriterijumu.

Kliknite na Filter kako biste zapoceli filtriranje, na Clear Filter za brisanje podeSavanja filtera.

Server Log Lists [# Log Filter [ Backup Log
Filter by Keyword: Clear Filter
Filter by Condition:

@) Filter by Condition: i More
Major Type: e Filter

Minor Type: v

6.3 Pravljenje kopije Log fajlova

Log fajlove, ukljucujuéi logove klijenata ali i server logove, moZete eksportovati.

Koraci:

1. Nakon pretrage log fajlova, obelezite log koji Zelite da eksportujete.
2. Kliknite na Backup Log kako biste nastavili postupak.

3. Kliknitena | iodaberite lokaciju na koju Zelite da sacuvate fajl.

Kliknite na Backup kako biste eksportovali fajl.

Mozete sa kliknete na File=>Open Log File kako biste proverili informacije o eksportovanju fajla na
racunar.

Backup Log.

Saving Path:

Backup Cancel
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7. Rad sa nalozima i sistemska podesSavanja

7.1 Rad sa nalozima

Visestruki korisnicki nalozi mogu se dodati u klijentski program, a Vi svakom pojedinacno mozete
dodeliti razli¢ita prava pristupa i privilegije.

=

Kliknite na @& ikonicu u okviru kontrolnog panela,

Ili kliknite na Tool->Account Management kako biste otvorili stranicu za podesavanje.

User List #ad User EontUser
Index Name Type

1 root Super User

Napomena: Nalog koji ste Vi kreirali da biste se prijavili u program ima status super administratora.

Dodavanje korisnickog naloga

Koraci:

1. Otvorite Account Management stranicu.

2. Kliknite na Add User kako biste otvorili prozor za dodavanije korisnika.
3. lzaberite tip naloga iz padajuceg menija. Dostupna su dva tipa naloga:

Administrator: Administratorski nalog podrazumevano ima sve dozvole, moguénost promene
Sifara i privilegija za sve operatorske naloge.

Operator: Operator nalog u startu nema nikakve dozvole i iste mu je potrebno dodeliti ru¢no.
Operator ima mogucnost promene SAMO Sifre na sopstvenom nalogu.

4. Unesite korisni¢ko ime, lozinkui potvrdite lozinku.

5. ObelezZite polja ispred opcija koje Zelite da dozvolite nalogu koji kreirate.

6. Opciono, moZete obeleziti Default Permission kako biste vratili podrazumevana podesavanja.
7. Kliknite na Save kako biste sacuvali podesavanja.

Napomene:

®  Korisni¢ko ime ne sme da sadrzi sledece parametre: /\ : * ? “ <> |. DuZina korisnickog imena ne
sme biti kra¢a od 6 karaktera.

® U klijentski program mozZete dodati do 50 korisnickih naloga.
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Add User x

User Information
User Type: Administrator - User Name:
Password Confirm Password:

User Live View related

< Al =) @ 1rct

< Live View + IPC1_Camera1l
+ PTZ Contral + & IPC2

+~ Capture + « DVR

+ Record + / IP Dome

+ Camera Seftings I

+ Play Back Remote Record File(s)

+ Download Remote Record File(s)

+ Remote Recording

+ Two-wayAudio

+ Synchronization

+ Picture Backup

Default Permission Save

Upravljanje nalogom

Nakon uspesnog kreiranja, nalog je dodat na listu korisnika.

MoZete menjati ili brisati postojeée naloge.
Ukoliko Zelite da izmenite podesSavanja na nalogu, izaberite nalog sa liste i kliknite na Edit User.

Ukoliko Zelite da obriSete nalog, izaberite nalog sa liste i kliknite na Delete User.

7.2 Sistemska podeSavanja

Opsta podesavanja, definisanje putanje za ¢uvanje fajlova, precice na tastaturi, alarmni zvukovi i E-mail
podesavanja definisu se u sklopu sistemskih podesavanja.

L
Kliknite na %% ikonicu u okviru kontrolnog panela,

Ili na Tool->System Configuration kako biste otvorili stranicu za podesavanje.

System Configuration x

iy File (Log expired time, display scale, play performance, etc.)

Set frequently used parameters

—
i3 Keyboard and Joystick

Log Expired Time Alontn ~
n Alarm Sound
View Scale: Full Screen ~
Email
Network Performance [Normal| | Better| |Best|
Play Performance: Real Time ~

+# Enable Screen Toolbar Display

() Enable Aute-login

+/ Prioritize the Playback of Record Files on Storage Server
+ Resume Live View Status

 Auto-change Stream Type

Auta Time Adjustment:

Default Value Save

Napomena: MoZete kliknuti na Default Value ukoliko Zelite da postavite podrazumevana sistemska
podesavanja.
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7.2.1 OpsSta podesavanja

Koraci:

1. Otvorite System Configuration stranicu.

2. Kliknite na General karticu kako biste otvorili prozor za podeSavanje.

3. Konfigurisite opsSte parametre. Za vise detalja, pogledajte tabelu 7.1 Opsti paramettri.
4

Kliknite na Save kako biste sacuvali podeSavanja.

Set frequently used parameters

(Log expired time, display scale, play performance, etc.)

Log Expired Time: AMonth -
View Scale; Original Resolution &
Metwork Performance: Mormal | | Better| | Best

Play Performance Real Time v

+/ Enable Screen Toolbar Display

Enable Auto-login

AN

Prioritize the Playback of Record Files on Storage Server

Resume Live View Status

5

Auto-change Stream Type

¥ Auto Time Adjustment: 00:00:01 =
Parametri Opisi
Log Expired Time Vreme do kog se ¢uvaju Log fajlovi. Nakon toga se brisu.

Format pregleda moze biti podesen na Full Screen, 4:3, 16:9 ili
originalnu rezoluciju

View Scale

Trenutni mrezni uslovi. Mogu biti podeseni na Normal, Better ili
Best

Network Performance

Performanse uZivog pregleda. Mogu biti podeSene na najmanje

Play Performance .. . I
v kasnjenje, Real Time, Balanced ili Fluency.

Prikaz linije sa alatkama na svakom prozru u kome ide prikaz sa

Enable Screen Toolbar Display kamera

Enable Auto-login Automatsko logovanje na klijentski program.

Prioritize the Playback of Record | Pustanje fajlova sa storage servera podrazumevano. U suprotnom,
Files pustanje snimaka sa uredaja na kome se snima lokalno.

Nastaviti pregled poslednjeg uZivo prikaza sa kamere nakon
ponovnog prijavljivanja u program.

Resume Live View Status

Automatska promena tipa strima u zavisnosti od veli¢ine prozora u

IR SR T kome se prikazuje video strim.

Auto Time Adjustment Automatsko prilagodavanje vremena.
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7.2.2 Definisanje putanje za skladiStenje fajlova

Video fajlovi ruénog snimanja, uslikani kadrovi i sistemski konfiguracioni fajlovi skladiSte se lokalno na
racunaru. Lokaciju na kojoj ce se fajlovi snimati mozZete samostalno da odredite.

Koraci:
1. Otvorite System Configuration stranicu.
2. Kliknite na File karticu kako biste pristupili podeSavanjima putanje.

3. Kliknite na ikonicu | i izaberite lokaciju na kojoj Zelite da se snimaju fajlovi.
4. Kliknite na taster Save kako biste sacuvali podeSavanja.

Set file saving path
(e.g. record files, pictures and device configuation files, etc.)

Saving Path of Video File:

|C.livms4200hideo/ -

Saving Path of Pictures:
C:ivms4200/capture/
Saving Path of Configuration File

C.ivms4200iconfig/

7.2.3 Podesavanje alarmnih zvukova

U slucajevima kada se alarm, poput alarma za detekciju pokreta, gubitka video signala, itd aktivira,
klijentski program, ukoliko je podesen, moze dati audio upozorenje.

Koraci:

Otvorite System Configuration stranicu.

Kliknite na Alarm Sound karticu kako biste otvorili prozor za podesavanja.
Kliknite na ikonicu | i odaberite audio fajl iz lokalnog foldera za Zeljeni alarm.

Opciono, kliknite na ikonicu * ¥ kako biste testirali audio fajl.

vk wN e

Kliknite na taster Save kako biste sacuvali podesavanja.

Napomena: Format audio fajla mozZe biti samo sa ekstenzijom *wav.

tection alarm,video exception alarm, alarm input and device exception alarm)

Motion Detection:
motion.wav

Video Exception:
video_abnormal.wav
Alarm Input
alarm_inputwav
Device Exception:

device_abnormal.wav
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8. Moguci problemi i reSenja

Prikaz uzivo - Live View
Problem:

®  Problem sa prikazom slike sa odredenog uredaja.

Moguci razlozi:

® Nestabilna mreza ili nedovoljni mrezni resursi.

® Uredaj nije aktivan — offline je.

®  PreviSe konekcija ka uredaju uzrokuje njegovo opterecenje i nemogucnost isporuke sadrzaja.
®  Trenutni korisnik sa nalogom nema privilegije i prava pristupa kako bi koristio ovu opciju.

® Verzija programa je ispod zahtevane

Resenja:

Proverite status mreze i iskljucite ostale procese na racunaru.

Proverite status mreZe na uredaju.

[ J
[ J
®  Restartujte uredaj ili iskljucite druge remote — daljinske sesije ka uredaju.
®  Prijavite se sa admin korisni¢kim imenom i pokusajte ponovo.

[ J

Preuzmite sa interneta poslednju verziju klijentskog programa.
Snimanje
Problem:
® Problem sa lokalnim i udaljenim snimanjem - razlike.
Objasnjenje:

® Lokalno snimanje u ovom priruéniku odnosi se na snimanje na HDD, SD/SDHC lokalnog uredaja

® Daljinsko snimanje se odnosi na akciju snimanja iniciranu od strane klijenta koji je na udaljenoj lokaciji.

Reprodukcija snimka

Problem:

® Problem sa preuzimanjem snimaka ili sporo preuzimanje snimaka.

Moguci razlozi:

® Nestabilna mreza ili nedovoljni mrezni resursi.
® Nekompatibilna mrezna kartica.

® PreviSe remote - daljinskih sesija ka uredaju.

® Trenutni korisnik sa nalogom nema privilegije i prava pristupa kako bi pregledao sadrzaj.
® Verzija programa je ispod zahtevane

Moguca resenja:

®  Proverite status mreze i iskljucite ostale procese na rac¢unaru.
® Povezite racunar direktno sa uredajem i proverite kompatibilnost mrezne kartice.
®  Restartujte ureda;j ili iskljucite druge remote — daljinske sesije ka uredaju.

®  Prijavite se sa admin korisnickim imenom i pokusajte ponovo.

[ J

Preuzmite sa interneta poslednju verziju klijentskog programa.
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SECTRON

/ll SECURITY & COMMUNICATION S5YSTEMS

Jurija Gagarina 11b

11000 Beograd

telefon: 011/2285-030 011/2285-031
faks: 011/2285-032

email: office@sectron.co.rs
www.sectron.co.rs ili www.sectron.com

Zabranjeno je svako neovlas¢eno kopiranje i umnozavanje, distribuiranje, ustupanje ijavno prikazivanje ovog
materijala ili bilo kojeg njegovog dela u komercijalne svrhe.
Sva prava proizvodaca i vlasnika dela su zadrzana.
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